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Introduction: What is a Geospatial PDF? 
 
A geospatial PDF is a file format used to store and distribute geospatial information. Geospatial PDFs: 

 may contain multiple map layers – including geographic features and aerial imagery – that can 
be toggled on or off;  

 have a known coordinate system, making geographic manipulation possible;  

 can be viewed with standard PDF readers like Adobe Reader; 

 can be analyzed geographically using plugins that provide functionality like length and area 
calculation. 

 
The geospatial PDF is an extension of the standard PDF (Portable Document Format) file originally 
developed by Adobe Systems. This proprietary file format became an open standard in 2008, when the 
file specification was published by the International Organization for Standardization (ISO) as ISO 32000-
1:2008 (http://www.iso.org/iso/home/news_index/news_archive/news.htm?refid=Ref1141).  
 
There are several methods to encode geographic information in a geospatial PDF, including an OGC 
(Open Geospatial Consortium) standard and the Adobe Systems Supplement to ISO 32000. Since these 
are open standards, creation and consumption of geospatial PDFs is possible in a variety of hardware 
and software environments.  
 
A “GeoPDF” is a specific type of geospatial PDF developed and trademarked by TerraGo, a US-based 
geospatial software and services company (http://www.terragotech.com/). GeoPDFs contain 
proprietary elements that allow the format to fully interact with TerraGo software. These software tools 
may not work the same way with standard geospatial PDFs.  
 

http://www.iso.org/iso/home/news_index/news_archive/news.htm?refid=Ref1141
http://www.terragotech.com/
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Several US federal agencies use GeoPDFs to distribute geospatial data, including the US Geological 
Survey (USGS) for its US Topo quads from the National Map. This technical paper will take a close look at 
these US Topo GeoPDFs as a case study. 
 
Geospatial PDFs have a number of advantages over other geospatial data formats, including the 
following. 

 The PDF is a familiar format used by millions of people. GIS software and experience is not 
needed to use geospatial PDFs. Software to read geospatial PDFs can be downloaded for free. 
For these reasons, geospatial PDFs promote broader adoption of digital map technology, 
especially by individuals with little or no GIS experience. 

 Functionality native to some PDF readers allows simple GIS-like functions to be performed, such 
as determining location and calculating lengths and areas. Toolbars can be added to these 
readers to permit more advanced functions such as adding markers and annotation, and 
digitizing features in geospatial exchange formats. 

 PDFs were developed to provide device-independent high-end graphics capabilities. Geospatial 
PDFs can be used to distribute high-quality finished maps for on-screen viewing or printing.  

 There are a number of geospatial PDF applications for mobile devices. These applications can be 
used for navigation in places where wireless coverage is limited. 

 Geospatial PDFs can be created using several different tools. 

 There are some large collections of maps in geospatial PDF format, including the newest USGS 
topographic map series. 

 
Geospatial PDFs have some limitations. A geospatial PDF is a static snapshot of a geospatial dataset. The 
file must be regenerated when the underlying data is updated. As such geospatial PDFs are often used 
to visualize geospatial data and for simple types of user interaction such as marking locations and 
measuring distances. However, geospatial PDFs do not offer the functionality of a geospatial database. 
 

Objectives of this Technical Paper 
 
This technical paper provides an overview of geospatial PDFs and their basic features, as well as some of 
the tools available to interact with these files. Some information is also provided on more complex 
software tools designed to manipulate and create geospatial PDFs, as well as several mobile apps. This 
paper focuses on USGS US Topos as a case study, since these maps are widely used.  
 

US Topos 
 
US Topos are digital topographic maps produced by the USGS and delivered in GeoPDF format. They 
replace the USGS’s legacy paper topographic maps, support more frequent updating and broader public 
distribution of data, and provide many advantages over traditional paper maps.  
 
US Topos:  

 provide nation-wide coverage using consistent symbolization 

 have the same format and scale as the legacy 7.5-minute USGS quads 
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 contain layers that can be turned on and off to customize the map 

 contain an orthophoto (rectified aerial photograph) base that can be turned on and off 

 are updated on a three year cycle (far more frequently than USGS paper maps were) 

 are based on authoritative, best-available source data 

 can be downloaded for free from the web 

 can be purchased in hard copy format for a small fee 

 can be printed from a personal computer (the whole map or a selected area) 

 are in the public domain with no copyright restrictions or license fees 

 can be viewed using free software 

 do not require GIS software or expertise to utilize 
 

For a video tutorial on US Topos see http://gallery.usgs.gov/videos/663. For a guide explaining how to 
use US Topos and other USGS topographic maps see http://nationalmap.gov/ustopo/quickstart.pdf.  

Other USGS topographic maps available on the web include all editions of USGS topographic maps that 
were originally published as paper maps. Copies of these maps have been scanned and converted to 
digital files and are available for free in GeoPDF format. More information about historical topographic 
maps is available at http://nationalmap.gov/historical. 
 

The USGS Store 
 
The USGS Store is a one-stop shop for USGS topographic maps, including historic maps and current US 
Topos. To access the store, go to http://store.usgs.gov and click on the Map Locator & Downloader link. 
 

 
USGS Store homepage 

  

http://gallery.usgs.gov/videos/663
http://nationalmap.gov/ustopo/quickstart.pdf
http://nationalmap.gov/historical
http://store.usgs.gov/
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You can use the Search box to search for place names, street addresses, or USGS map names. 
 

 
Map locator and search function 

 
When you enter a search word, a red pushpin will appear on the map showing the location you searched 
for. The map will pan and zoom to this point automatically.  
 

 
Search feature identified 
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To search for a street address, enter the full address in the search tool. 
 

 
Searching for a street address 

 
You can also use the zoom and pan tools to navigate to an area of interest. Next, click the MARK POINTS 
button and then click on the map. A red pushpin will appear.  
 

 
Mark a point on the map 
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To see all of the USGS maps available for a selected point, simply click on the pushpin for that point. 
 

 
Available USGS maps for a selected point 

 
In the example above, the first row (Madison East US Topo Revision 1) is the newest US Topo map from 
2013. The second row is an earlier version of this map from 2010. Subsequent rows (not all are shown in 
the graphic) are older USGS maps. 
 
Click on the blue underlined link under the Download column to download a map. Click on a link in the 
View column to view the map on-screen. If you want to purchase a printed copy of the map, click on the 
map name in the Buy column. You will need to create a USGS account to purchase a printed map. 
 

 
Options for viewing, downloading and purchasing maps 
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Using Geospatial PDFs in a PDF Reader 
 
Adobe Reader and Adobe Acrobat are two of the most widely used PDF readers. Either reader can be 
used to read and manipulate US Topos, scanned USGS historic topographic maps, and other geospatial 
PDFs. There are many alternatives to Adobe’s PDF readers, but not all of these alternatives are able to 
make use of the geographical information encoded in geospatial PDFs.  
 
Adobe Reader is available for free from http://get.adobe.com/reader. Once this software is installed, 
you can open a geospatial PDF by simply double-clicking on it. The image below is a screen-shot similar 
to what you will see when the map opens. 
 

 
Screenshot of a US Topo map (with different parts of the map labeled) 

 
The areas labeled 1 through 6 on the map are as follows: 

1. Table of contents containing a list of the map layers.  

2. Datum and dates/sources of map content. 

3. North arrow. 

4. Scale information. 

5. Simple legend. A more detailed legend can be found at 
http://nationalmap.gov/ustopo/images/US_Topo_Map_Symbols.pdf 

6. PDF controls and tools. 

  

http://get.adobe.com/reader
http://nationalmap.gov/ustopo/images/US_Topo_Map_Symbols.pdf
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Layers can be turned on and off by clicking on the eye icon next to the layer name. Layer groups can be 

expanded or collapsed by clicking on the + or – icons. 

 

 
Table of contents and map layers 

 

You can zoom in and out on the map using the – and + buttons on the Adobe Reader toolbar. 

 

 
Zoom tool 

 
Depending on your PDF reader, some geospatial features may already be available. For example, in 
Adobe Reader XI, you can choose the Geospatial Location Tool under Analysis in the Edit menu.  

 

 
Geospatial Location Tool in Adobe Reader XI 
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The Geospatial Location Tool will dynamically display the cursor location as you move across the map. 
 

 
Dynamic display of location 

 
To change the format of the location display, choose Preferences from the Edit menu, and then choose 
Measuring (Geo) from the Categories list. You can change the latitude-longitude format from Decimal 
to Degrees, Minutes, Seconds.  
 

 
Geographic measurement preferences 
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To measure lengths and areas on the map, choose Measuring Tool under Analysis in the Adobe Reader 
Edit menu. A measurement display and associated toolbox will be displayed on the map. 
 

 
Measurement display and toolbox 

 
You can choose to measure length, perimeter, or area from the appropriate icons under Measurement 
Types. Then, draw the shape you want to measure and the results will be displayed. 
 
To measure distance, click on your starting point and then your ending point. 
 
To measure perimeter, click on a corner point of the object you are measuring, click on the next corner 
point, continue doing this around the object, and double-click to finish. 
 
To measure area, click on a corner point of the object you are measuring, click on the next corner point, 
continue doing this around the object, and then click the first point to finish. 
 
The Snap Types options allow you to define the drawing environment for your shapes. For example, 
clicking the Snap to Paths icon (the first of the icons under Snap Types) will cause new points that you 
draw to snap to a nearby line (path).  
 
To change the units for distance or area, choose Preferences from the Adobe Reader Edit menu, and 
then choose Measuring (Geo) from the Categories list. You will be able to choose a variety of distance 
units (meters, kilometers, feet, US feet, miles and nautical miles) and area units (square meters, 
hectares, square kilometers, square feet, acres and square miles). 
 
One limitation of native geospatial functionality in Adobe Reader is that no projection or datum 
information is provided, and projections and datums cannot be changed for coordinate display. To 
obtain this functionality, the TerraGo GeoPDF Toolbar is needed. 
 

TerraGo GeoPDF Toolbar 
 
The TerraGo GeoPDF Toolbar – a plug-in for Adobe Reader or Acrobat – is recommended by the USGS 
for those who want more functionality for GeoPDFs. This toolbar can be downloaded for free from 
http://www.terragotech.com/products/field-data-collection/terrago-toolbar. The toolbar is designed for 
GeoPDFs, such as US Topos, and will not function the same way with standard geospatial PDFs.  
 
  

http://www.terragotech.com/products/field-data-collection/terrago-toolbar
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After installation, the TerraGo toolbar can be accessed via the TerraGo menu (at 1 in the figure below) 
or through the Extended tab in the PDF controls area (at 2 in the figure below).  
 

 
After installing the TerraGO GeoPDF Toolbar 

 
Some of the features of the TerraGo toolbar are already built in to current versions of Adobe Reader and 
Acrobat, such as dynamic display of cursor location (at 3 in the figure above).  
 
To access TerraGo functions, click on the Extended tab in the PDF controls area. You will now have a 
GeoPDF toolbar (locational and measurement tools) and a GeoMark toolbar (annotation and 
collaboration) to choose from.  
 
For tracking locations on the map, choose the GeoPDF toolbar and click on the GeoLocator tool.  
 

 
GeoLocator tool 

 
To modify the coordinate format (e.g., decimal degree, degree-minute-second, etc.) go to the Edit 
menu, choose Preferences and then TerraGo…   
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Next choose Coordinate Display and select the desired display option from the drop-down list. 
 

 
Modifying the coordinate format 

 
The GeoLocator tool also allows you to change the coordinate display to a desired projection. To change 

the coordinate display, use the > button and choose Set Projection Parameters. In the resulting 

Coordinate System Selector you can choose a predefined coordinate system or a custom one.  
 

 
TerraGO Coordinate System Selector 

 
For Wisconsin, commonly used coordinate systems include UTM Zone 16N (NAD83 or WGS84 versions), 
NAD83 (HARN)/Wisconsin Transverse Mercator, and NAD83 (HARN)/Wisconsin Central, North or 
South (state plane system).  
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The coordinate display will now reflect the chosen coordinate system. 
 

 
GeoLocator tool with selected coordinate system 

 
A useful feature is the Google Map tool. By right-clicking on a location on the map, a Google map of this 
location will open in your browser. 
 

 
Google Map tool 

 
To measure length or area, choose the GeoMeasure tool from GeoPDF toolbar, and draw a shape on the 
map. In the example below, the aerial image layer of the GeoPDF has been turned on so that the outline 
of a property can be traced. 
 

 
Measuring area on the map 

 
You can modify the length and area units by setting the TerraGo preferences (Edit menu  Preferences 
 TerraGo…  GeoMeasure Tool Options). 
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The GeoMark toolbar allows you to add annotation to the map. For example you can add sticky notes 
and draw polygons.  
 

 
Drawing shapes on the map 

 
These objects are georeferenced, which means that they have real-world coordinates. Clicking on an 
object allows you to see these coordinate values. 
 

 
Coordinate values for a shape 

 
These objects can be saved (using Export GeoMarks under Collaboration in the GeoMarks toolbar) and 
then imported into another GeoPDF or by another user (Using Import GeoMarks under Collaboration in 
the GeoMarks toolbar). Another feature of the TerraGo toolbar is the ability to generate GPS tracks. 
 

Making Prints and Digital Copies 
 
There are several options for printing geospatial PDFs. For USGS Topos, a paper copy of the entire map 
can be purchased on the USGS store. For geospatial PDFs not available for purchase, native Adobe 
Reader tools can be used to print the map. Users can print the entire map or a selected portion. 
Likewise, users can save selected portions of the map as a PDF and then further manipulate these files 
using image editing software like Adobe Photoshop. 
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To print or save a portion of a geospatial PDF, zoom in on the area of interest, and then select Print 
under the File menu. In the Print dialog box, choose Current view under More Options in the Pages to 
Print section. You can also configure the print size and choose the printer in this dialog box.  
 

 
Printing a portion of a map 

 
To save a digital copy rather than print a copy, simply choose Adobe PDF in the Printer drop down list 
and click Print. This will save the selected portion of the map to a new PDF file. You will be prompted for 
a filename and location. Note that the resulting file will be a standard PDF, not a geospatial PDF. You will 
not be able to turn layers on and off (the file will have been flattened) and georeferencing information 
will have been discarded. 
  

Creating Geospatial PDFs 
 
At present, creating a geospatial PDF requires the use of additional software or the ability to write a 
custom program. Most GIS packages do not at present support geospatial PDF creation. Among the 
options for creating geospatial PDFs are the following: 

 TerraGo Publisher, an extension for ArcGIS and other GIS software 
(https://www.terragotech.com/products)  

 Global Mapper by Blue Marble Geographics (http://www.bluemarblegeo.com/products/global-
mapper.php)  

 FME software by SAFE Systems 
(http://docs.safe.com/fme/html/FME_ReadersWriters/Default.htm#pdf2d/pdf2d.htm)  

https://www.terragotech.com/products
http://www.bluemarblegeo.com/products/global-mapper.php
http://www.bluemarblegeo.com/products/global-mapper.php
http://docs.safe.com/fme/html/FME_ReadersWriters/Default.htm#pdf2d/pdf2d.htm
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 Interoperability Extension for ArcGIS by Esri 
(http://www.esri.com/software/arcgis/extensions/datainteroperability)  

 MAPublisher and Geographic Imager by Avenza Systems (http://www.avenza.com/products)  

Note that this is not necessarily an exhaustive list. License fees and capabilities of these software 
packages vary, so users should consult relevant information before purchasing. For the DIY crowd, open 
source libraries such as GDAL can be used to write customized programs to read and write geospatial 
PDFs (http://www.gdal.org/frmt_pdf.html).  
  

Mobile Apps 
 
For mobile devices, there are several new apps that interact with geospatial PDFs. One example is 
Avenza Systems’ PDF Map application for iOS and Android (http://www.pdf-maps.com/about-pdf-
maps). The app, which can be downloaded for free, allows smartphone and tablet users to plot locations 
with pushpins, make GPS tracks, and measure distance and area. Users can also link photos. A screen 
shot of the application is shown below. 
 

 
PDF Map application 

 
Avenza’s Map Store provides a variety of geospatial PDFs that can be purchased or in some cases 
downloaded for free. Scanned versions of the older USGS paper topographic maps are available on the 
store. You can also download and use your own geospatial PDFs through iTunes or an ftp site. When PDF 
Map imports a user-generated map, it converts it to a raster format such that map layers cannot be 
turned off and on.  
 
TerraGo’s Publisher and Composer software tools are also tuned toward mobile geospatial PDF 
applications. TerraGo software allows users to create GEoPDFs, integrate them into customizable 
interactive applications, and provide geospatial functionality on a variety of platforms 
(https://www.terragotech.com). 
 
An advantage of building mobile apps based on geospatial PDFs is that geospatial information can be 
used anywhere, even if wireless access is limited.  

  

http://www.esri.com/software/arcgis/extensions/datainteroperability
http://www.avenza.com/products
http://www.gdal.org/frmt_pdf.html
http://www.pdf-maps.com/about-pdf-maps
http://www.pdf-maps.com/about-pdf-maps
https://www.terragotech.com/
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What’s Next? 
 
Geospatial PDFs have many advantages, including portability, quality of map rendering, ease of printing, 
and ease of use. Geospatial PDFs can be viewed using free software that is familiar to millions of users. 
For these reasons, geospatial PDFs support the broader adoption of digital geospatial technology, 
especially by individuals with little or no GIS experience. The end result is that geospatial information 
can more readily be integrated into existing workflows and operations.  
 
This paper focuses primarily on reading and interacting with geospatial PDFs, although some pointers to 
geospatial PDF creation are also noted. Additional details on geospatial PDF creation are a possible topic 
for a future edition of this paper. 
 
 
 
 


